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1 Preface 

1.1 Introduction to the Data Logger 
This manual describes the installation, configuration, operation, and diagnostics of the 
PLX51-DL-232. The PLX51-DL-232 can read and store data from Logix Controllers, DF1 
Serial Interfaces, or Modbus devices. The PLX51-DL-232 has the capacity to store over 
16 million records in its solid-state non-volatile memory. Each stored record includes a 
Date Time stamp with a 50 ms resolution, Tag Name, Data Type, and Value. 

The PLX51-DL-232 can be used to log data at a remote site with limited communication 
with its base. The PLX51-DL-232 is also used to store records on mobile equipment 
such as trucks, drilling rigs, or snow plows. Once the equipment returns back to its base, 
the historical data can be uploaded and transferred to a more permanent storage device. 
The PLX51-DL-232 can also be configured to collect data which is only downloaded and 
examined if a fault occurs, otherwise the data is overwritten. 

 

Figure 1.1. – Non-Historian Option 

1.2 Features 
The PLX51-DL-232 provides temporary extensive on-board storage capability for storing 
process tags. A total of 16,777,216 records can be stored in its non-volatile memory. 
Each record consists of the following data: 

Table 1.1. – Components of a Record 

Parameter Link 

Date Time 
UTC Time includes: Year, Month, Day, Hour, Minute, Second, Milliseconds. 
Time has a resolution of 50 milliseconds. 

Tag Name As defined in Controller or in the PLX50 Configuration Utility for other sources 

Data Type BOOL, SINT, INT, DINT, or REAL 

Value Logix Tag / DF1 File / Modbus Register value 
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The Log Index is managed by the PLX51-DL-232 and incremented each time a new 
record is stored. The Unload Index is managed externally by the unload service. It is 
only incremented after a record has been logged successfully to a text file. The records 
can be unloaded in Logix with the Example Code. Both the Log Index and Unload 
Indices loop around, eventually reaching the end of the cache. The cache becomes 
100% full when the Log Index loops around and equals the Unload Index. In this 
situation, either older records are overwritten (Log Mode = Overwrite) or newer records 
are not logged (Log Mode = Hold). 

 

Figure 1.2. - Memory Schematic 

The PLX51-DL-232 is configured using the ProSoft PLX50 Configuration Utility. This 
program can be downloaded from www.prosoft-technology.com, free of charge. The 
PLX50 Configuration Utility offers various configuration methods, including a controller 
tag browser. The PLX50 Configuration Utility can also be used to monitor the status and 
download historical data to a local file. 
The PLX51-DL-232 can operate in both a Logix “owned” and standalone mode. With a 
Logix connection, the input and output assemblies provide additional diagnostics 
information. This information is available in the Logix controller environment.  
The PLX51-DL-232 uses isolated RS232 for DF1 communication. The RS232 port also 
uses a terminal block for convenient installation.  
A built-in webserver provides detailed diagnostics of system configuration and operation.  

http://www.prosoft-technology.com/


PLX51-DL-232  Preface 
Data Logger  User Manual 

 

ProSoft Technology, Inc. Page 8 of 59 
 

1.3 Additional Information 
The following documents contain additional information that can assist you with 
installation and operation. 

Table 1.2. - Additional Information 

Resource Link 
PLX50 Configuration 
Utility Installation www.prosoft-technology.com 

User Manual 
Datasheet 
Example Code & UDTs 

www.prosoft-technology.com 

Ethernet wiring standard www.cisco.com/c/en/us/td/docs/video/cds/cde/cde205_220_420/installation/guid
e/cde205_220_420_hig/Connectors.html 

CIP Routing The CIP Networks Library, Volume 1, Appendix C:Data Management  

http://www.prosoft-technology.com/
http://www.prosoft-technology.com/
http://www.cisco.com/c/en/us/td/docs/video/cds/cde/cde205_220_420/installation/guide/cde205_220_420_hig/Connectors.html
http://www.cisco.com/c/en/us/td/docs/video/cds/cde/cde205_220_420/installation/guide/cde205_220_420_hig/Connectors.html
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2 Installation 

2.1 Module Layout 
The PLX51-DL-232 has three ports at the bottom of the enclosure, as shown in the 
figure below. The ports are used for Ethernet, RS232 serial, and power.  
The DC power port uses a three-way connector (+ positive, - negative, and Earth). 
The RS232 port uses a four-way connector (Tx Transmit, Rx Receive, Gnd Ground, and 
Shield earth connection).  
The Ethernet cable must be wired according to industry standards which can be found in 
the additional information section of this document. 

 

Figure 2.1. – Data Logger side and bottom view 

The PLX51-DL-232 provides three diagnostic LEDs (Ok, Act, and Eth). These LEDs 
provide information on system operation, the Ethernet interface, and the auxiliary 
communication interface (RS232). 
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Figure 2.2. – Module front and top view 

The PLX51-DL-232 has four DIP switches at the top of the enclosure as shown above.  
Table 2.1. - DIP Switch Settings 

DIP Switch Description 
DIP 1 Used to force the PLX51-DL-232 into “Safe Mode”. When in “Safe Mode”, the 

PLX51-DL-232 does not load the application firmware. It waits for new firmware to 
be downloaded. This should only be used when a firmware update was interrupted 
at a critical stage.  

DIP 2 Used to force the PLX51-DL-232 into DHCP mode, useful when the user has 
forgotten the IP address of the PLX51-DL-232. 

DIP 3 Reserved 

DIP 4 Reserved 
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2.2 Module Mounting 
The PLX51-DL-232 provides a DIN rail clip to mount onto a 35mm DIN rail.  

 

Figure 2.3. - DIN rail specification 

The DIN rail clip is mounted on the bottom of the PLX51-DL-232. Use a flat screw driver 
to pull the clip downward. Once the PLX51-DL-232 is mounted onto the DIN rail, the clip 
must be pushed upward to lock the PLX51-DL-232 in place. 
 

 

Figure 2.4. - DIN rail mouting 
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2.3 Power 
A three-way power connector is used to connect + positive, - negative, and Earth. The 
PLX51-DL-232 requires an input voltage of 10 to 28 Vdc.  

 

Figure 2.5. - Power connector 

2.4 RS232 Port 
The RS232 connector is used to connect the Transmit (Tx), Receive (Rx), and Ground 
conductors for serial communication. The shield terminal can be used for shielded cable 
in high noise environments.  

Important: The shield of the RS232 port is internally connected to the power connector earth. Thus, when 
using a shield it is important to connect the Earth terminal on the power connector to a clean earth. Failing 
to do this can lower the signal quality of the RS232 communication. 

Important: When using a shielded cable, it is important that only one end of the shield is connected to earth 
to avoid current loops. It is recommended to connect the shield to the PLX51-DL-232, and not to the other 
Serial device. 

 

Figure 2.6. - RS232 connector 

2.5 Ethernet Port 
The Ethernet connector should be wired according to industry standards. Refer to the 
additional information section in this document for further details. 
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3 Setup 

3.1 Install Configuration Software 
The PLX51-DL-232 is configured using the PLX50 Configuration Utility environment. 
This software can be downloaded from www.prosoft-technology.com. 

 

Figure 3.1. - PLX50 Configuration Utility Environment 

http://www.prosoft-technology.com/
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3.2 Network Parameters 

3.2.1 DHCP Server Settings 
By default, the PLX51-DL-232 has DHCP (Dynamic Host Configuration Protocol) 
enabled. Thus, a DHCP server must be used to provide the PLX51-DL-232 with the 
required network parameters (IP address, subnet mask, etc.). There are a number of 
DHCP utilities available. However, it is recommended to use the DHCP server in the 
PLX50 Configuration Utility. 

1 Within the PLX50 Configuration Utility, click on TOOLS > DHCP SERVER. 

 

Figure 3.2. - Selecting DHCP Server 

2 Once opened, the DHCP server listens on all available network adapters for DHCP 
requests and displays their corresponding MAC addresses. 

 

Figure 3.3. - DHCP Server 
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Note: If the DHCP requests are not displayed in the DHCP Server, it may be due to the local PC’s firewall. 
During installation, the necessary firewall rules are automatically created for the Windows firewall. Another 
possibility is that another DHCP Server is operational on the network and it has assigned the IP address. 

3 To assign an IP address, click on the corresponding ASSIGN button. The Assign IP 
Address  dialog box opens. 

 

Figure 3.4. - Assigning IP Address 

 The required IP address can then be either entered, or a recently used IP address 
can be selected by clicking on an item in the Recent list. 

If the Enable Static checkbox is checked, the IP address will be set to static after the 
IP assignment, thereby disabling future DHCP requests. 

4 Click OK when complete. 

5 Once the Assign IP Address dialog box has been accepted, the DHCP server 
automatically assigns the IP address to the PLX51-DL-232 and reads the Identity 
Object Product name from the device. The device indicates a green background 
upon successful assignment of the IP address. 

 

Figure 3.5. - Successful IP address assignment 
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It is possible to force the PLX51-DL-232 into DHCP mode by powering up the device 
with DIP switch 2 in the On position. A new IP address can then be assigned by 
repeating the previous steps.  

Important: It is important to return DIP switch 2 back to Off position, to avoid the PLX51-DL-232 returning to 
a DHCP mode after the power is cycled again. 

In addition to the setting the IP address, other network parameters can be set during the 
DHCP process. These settings can be viewed and edited by clicking on TOOLS > 
APPLICATION SETTINGS. 

3.2.2 Network Settings 
Once the DHCP process has been completed, the network settings can be set using the 
Ethernet Port Configuration via the Target Browser. 

1 Click on Tools > Target Browser 

 

Figure 3.6. - Selecting the Target Browser 

2 The Target Browser automatically scans the Ethernet network for EtherNet/IP 
devices. 

 

Figure 3.7. - Target Browser 
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3 Right-clicking on a device reveals the context menu, including the Port Configuration 
option. 

 

Figure 3.8. - Selecting Port Configuration 

4 All relevant Ethernet port configuration parameters can be modified using the Port 
Configuration dialog box. 

 

Figure 3.9. - Port Configuration 

Alternatively, these parameters can be modified using the Rockwell Automation 
RSLinx software. 
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3.3 Creating a New Project 
Before you configure the PLX51-DL-232, a new PLX50 Configuration Utility project must 
be created.  

1 Click on File > New. 

 

Figure 3.10. - Creating a new project 

2 A new project is created and displayed in the Project Explorer tree view.  

3 Add a new device by clicking on DEVICE > ADD. 

 

Figure 3.11 - Adding a new device 
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4 In the Add New Device dialog box, select the PLX51-DL-232 and click the Ok button.  

 

Figure 3.12 – Selecting a new PLX51-DL-232 

5 The device appears in the Project Explorer tree, and its configuration window is 
opened. The device configuration window can also be opened by double-clicking the 
PLX51-DL-232 icon in the Project Explorer tree, or right-clicking the PLX51-DL-232 
icon and selecting Configuration. 

 

Figure 3.13 – PLX51-DL-232 configuration 
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3.4 Configuring the PLX51-DL-232 
The PLX51-DL-232 is configured by the PLX50 Configuration Utility. The configuration 
consists of a general configuration, serial configuration for DF1 or Modbus RTU, data 
source configuration, and tag selections. The PLX51-DL-232 configuration is saved in 
non-volatile memory that persists when the PLX51-DL-232 is powered down.  

Important: When a firmware upgrade is performed, the PLX51-DL-232 will clear all configuration and 
cached records.  

3.4.1  General Tab 
The general configuration is shown in the figure below. The general configuration 
window is opened by either double-clicking on the PLX51-DL-232 icon in the tree, or 
right-clicking the PLX51-DL-232 icon and selecting Configuration.  

 
Figure 3.14 - General Configuration (Data Logger) 

The general configuration consists of the following parameters: 
Table 3.1 - General configuration parameters 

Parameter Description 
Instance Name This parameter is a user defined name to identify between various PLX51-DL-

232’s. 

Description This parameter is used to provide a more detailed description of the PLX51-DL-
232.  

Major Revision The major revision of the PLX51-DL-232. 

IP Address The PLX51-DL-232’s IP address used by the PLX50 Configuration Utility to 
communicate with the PLX51-DL-232.  

Data Source This parameter selects the source of the data. 
Logix – Rockwell Automation ControlLogix or Compact Logix controller 
DF1 – Serial DF1  
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Parameter Description 
ModbusRTU – Serial Modbus 
ModbusTCP – Modbus over Ethernet 

Logging Mode This parameter determines if records are overwritten once the memory is filled. 
Overwrite = Old records are overwritten, giving priority to newer data. 
Hold = Old records are preserved while new records are not stored. 

3.4.2 Serial Tab 
The Serial tab is shown in the figure below. The Serial configuration is opened by either 
double-clicking on the PLX51-DL-232 icon in the tree, or right-clicking the PLX51-DL-232 
icon and selecting Configuration. Select the Serial tab. 

 

Figure 3.15 - Serial configuration 

The Serial configuration (Serial tab) consists of general Serial and DF1-specific 
parameters. For Modbus RTU, only the Baud Rate and Parity need be configured. 

Table 3.2 - Serial ModbusRTU and DF1 configuration parameters 

Parameter Description 
Baud Rate This configures the speed of the data that is sent across the RS232 serial 

network. The PLX51-DL-232 provides the following speeds: 
1200, 2400, 4800, 9600, 19200, 38400, 57600, and 115200 

Parity This configures the parity of the RS232 serial port. The PLX51-DL-232 allows 
for Even, Odd, or None. 

Protocol This configures the PLX51-DL-232 to operate in full duplex or half duplex 
mode on the DF1 network. 

Error Detection The PLX51-DL-232 can be configured to perform either BCC or CRC 
checksum validation on incoming and outgoing packets. CRC checksums is a 
much stronger validation method, but is more processor-intensive to perform. 

Embedded Response This configures the PLX51-DL-232 to add the acknowledge responses in the 
data payload. It can be configured to be Auto Detect or On. 
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Parameter Description 
This function is only available in Full Duplex mode. 

Node Address The node address is the local node address of the PLX51-DL-232. 
 

Retry Limit This determines how many times the PLX51-DL-232 must retry and message 
exchange before failing it. 

Timeout This determines the interval between retries for a failed message exchange. 

Reply Msg Wait This is the minimum delay before the DF1 reply is transmitted to the DF1 
device. 

Duplicate Detection This configures the PLX51-DL-232 to check for duplicate packets and flagging 
them. 

3.5 Data Source Configuration 
The Data Source tabs determine the PLX51-DL-232 communication mode used to 
acquire data. The Data Source options include: 

• Logix Source – ControlLogix and Compact Logix controllers 

• DF1 Source – For collecting data over DF1 Serial communications 

• Modbus Source – for ModbusRTU (Serial) and ModbusTCP (Ethernet) 
communications 

Once the data source is selected, each tab allows the configuration of up to three source 
devices and a total of 200 tags. 
Tags can be logged as a result of their individual log criteria or via a group trigger. There 
are eight trigger groups (A thru H), and a tag can be a member of any trigger group. 
Groups are in turn triggered by one or more tags. The triggering of a group ensures all 
its member’s values are logged at the same instance. 

3.5.1 Group and Tag Triggers  
Three parameters determine when a tag is triggered: 

• Delta Y (Δy) – A change in the value of the tag by this amount or more, AND 

• Min ΔT – The minimum time in seconds between each consecutive trigger, OR 

• Max ΔT – The maximum time between each consecutive trigger. Setting the Max 
ΔT to ‘0’ disables the “heartbeat” and allows you to log on trigger. 
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The first two parameters work together to ensure tags are not logged too frequently, and 
the Max ΔT is set at a minimum logging frequency.  

 

Figure 3.16 – Group and Tag Triggers 

3.5.2 Logix Source 
The Logix Source tab is used to configure tags from Rockwell Automation Logix 
controllers over EtherNet/IP. The PLX51-DL-232 can read tags from up to three 
separate controllers. A Target Name must be provided. This acts as a reference to the 
Logix CIP path. The Target Name does not have to match the actual controller name set 
in RSLogix. The Controller’s CIP Path can either be typed in or selected from a list in the 
Target Browser. 

 
Figure 3.17 – Logix Source Configuration Tab 
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6 Click the BROWSE button in the browse column to launch the Target Browser. The 
Target Browser opens and automatically scans for all available EtherNet/IP devices. 

 

Figure 3.18 – Target Browser Window 

7 If the Ethernet/IP module is a bridge module, it can be expanded by right-clicking on 
the PLX51-DL-232 icon and selecting the Scan option. 

 

Figure 3.19 - Scanning node in the Target Browser 

8 The Logix controller can be selected by clicking the Ok button, or by double-clicking 
on the controller module. 
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9 Once the controller references have been configured, the individual Logix tags can 
be added. Tags can either be entered manually or selected by using the Tag 
Browser associated with each controller. 

 

Figure 3.20 - Logix Tag configuration 

Important: Tag names need to match in order for the PLX51-DL-232 to correctly identify the tag. Full tag 
names are needed for tags to be located in program scopes. 

10 To launch the Tag Browser, click the BROWSE TAGS button associated with the 
controller. Tags that are were already selected and identified are highlighted in 
green. See Fig 3.24. 

 

Figure 3.21 – Tag Browser Selection 
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11 Tags can be removed by selecting the rows in the left margin, and right-clicking to 
display the DELETE option. 

 

Figure 3.22 – Deleting Tags 

3.5.3 DF1 Source 
A maximum of three DF1 Sources can be configured. The configuration of each source 
requires a Device Name (used as a reference for tag data sources), the Device Type 
(either PLC5 or SLC), and a Node Address.  
Each DF1 Tag requires a unique Tagname and Data Address. 

 

Figure 3.23 – DF1 Source configuration 
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3.5.4 Modbus Source 
Both Modbus RTU and Modbus TCP/IP are configured using the Modbus Source tab. 
For Modbus RTU, a maximum of three Modbus sources can be configured. The 
configuration of each source requires a Device Name (used as a reference for tag data 
sources), the IP Address (Modbus TCP/IP only), and a Node Address.  

 
Fig 3.24 – Modbus Source Configuration 

3.6 Module Download  
Once the configuration is complete, it must be downloaded to the PLX51-DL-232. 
Before downloading, the connection path of the PLX51-DL-232 should be set. This path 
automatically defaults to the PLX51-DL-232 IP address, as set in the PLX51-DL-232 
configuration. It can be modified if the PLX51-DL-232 is not on a local network. 

1 The connection path can be set by right-clicking on the PLX51-DL-232 icon and 
selecting the Connection Path option. 

 

Fig 3.25 – Modbus Source Configuration 
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2 The new connection path can be entered manually or selected by means of the 
Target Browser. 

 

Figure 3.26 - Connection Path 

3 To initiate the download, right-click on the PLX51-DL-232 icon and select Download. 

 

Figure 3.27 - Connection Path 

4 Once complete, you will be notified that the download was successful. 

 

Figure 3.28 - Successful download 
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5 During the download process, the PLX51-DL-232’s time will be compared to that of 
the PC’s time. Should the difference be greater than 30 seconds, you will be 
prompted to set the PLX51-DL-232 time to that of the PC time. 

 

Figure 3.29 – Setting module time 

6 The PLX51-DL-232 time is used only for the event log. Within the PLX50 
Configuration Utility environment, the PLX51-DL-232 will be in the Online state, 
indicated by the green circle around the PLX51-DL-232 icon.  

 

Figure 3.30 - Module Online 

7 The PLX51-DL-232 is now configured.  
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4 RSLogix 5000 Configuration 

4.1 Add Module to I/O Configuration 
The PLX51-DL-232 can operate in both a Logix “owned” and standalone mode. When 
the PLX51-DL-232 operates in a Logix “owned” mode, the PLX51-DL-232 needs to be 
added to the RSLogix 5000 / Studio5000 IO tree, as a generic Ethernet module.  

1 Right-click on the Ethernet Bridge in RSLogix 5000 and select New Module. Then 
select ETHERNET-MODULE and click Ok.  

 

Figure 4.1 - Add a Generic Ethernet Module in RSLogix 5000 

2 Enter the IP address of the PLX51-DL-232. The Assembly Instance and Size must 
also be added for the input, output, and configuration in the Connection Parameters 
section. Below are the required connection parameters. 

Table 4.1 - RSLogix class 1 connection parameters for the Data Logger 

Connection Parameter Assembly Instance Size 
Input 103 29 (32-bit) 

Output 104 1 (32-bit) 

Configuration 102 0 (8-bit) 
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Figure 4.2 - RSLogix General module properties in RSLogix 5000 

3 Add the connection requested packet interval (RPI). This is the rate at which the 
input and output assemblies are exchanged. The recommended value is 500 ms. 
Refer to the technical specification section in this document for further details on the 
limits of the RPI. 

Important: Although the PLX51-DL-232 is capable of running with an RPI of 10 ms, it is recommended to 
set the RPI to 500 ms to avoid unnecessary overloading of the PLX51-DL-232 processor. 

 

Figure 4.3 - Connection module properties in RSLogix 5000 
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4 Once the PLX51-DL-232 has been added to the RSLogix 5000 IO tree, assign the 
User Defined Types (UDTs) to the input and output assemblies. You can import the 
required UDTs by right-clicking on the User-Defined sub-folder in the Data Types 
folder and selecting Import Data Type. The assemblies are then assigned to the 
UDTs with a ladder copy instruction (COP).  

 

Figure 4.4 – RSLogix 5000 I/O module tree 

4.2 Importing UDT’s and Mapping Routines 
To simplify the mapping of the input image, an RSLogix 5000 Routine Partial Import 
(.L5X) file is provided.  

1 Right-click on the required Program and select the Import Routine option. 

 

Figure 4.5 – RSLogix 5000 Importing Data Logger specific routine and UDTs 
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2 Select the proper .L5X file. 

 
Figure 4.6 - Selecting partial import file 

The import creates the following: 

• The required UDTs (user defined data types) 

• Controller tags representing the Input Assembly. 

• A routine mapping the PLX51-DL-232 to the aforementioned tag. 
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3 You may need to change the routine to map to the correct PLX51-DL-232 instance 
name. Make sure that the mapping routine is called by the Program’s Main Routine. 

 

Figure 4.7 - Imported RSLogix 5000 objects 

Refer to the Additional Information section of this document for an RSLogix 5000 
project example, as well as the required UDTs. 
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4.3 RSLogix 5000 assemblies 
When the PLX51-DL-232 operates in a Logix “owned” mode, the Logix controller 
establishes a class 1 cyclic communication connection with the PLX51-DL-232. An input 
assembly is exchanged at a fixed interval. The provided UDTs convert the input arrays 
into tag-based assemblies. Refer to the Additional Information section in this document 
for more information on the input UDTs. There are no Output or Configuration 
assemblies. 

 

Figure 4.8 - Input assembly UDT structure 

4.3.1 Input Assembly 
The following parameters are used in the input assembly of the PLX51-DL-232. 

Table 4.2 - RSLogix 5000 input assembly parameters 

Parameter Datatype Description 
Instance STRING Instance name of the PLX51-DL-232 that was configured under 

the General Configuration tab in the PLX50 Configuration 
Utility. 

Status.Running BOOL Set if the PLX51-DL-232 has a valid configuration and is 
reading tags.  

Status.ConfigValid BOOL Set if a valid configuration is executing in the PLX51-DL-232. 

Status.ContinuousLogging BOOL Set if Logging Mode is set to Overwrite, clear for Hold. 

Status.ConfigurationValid BOOL Set if a valid configuration is executing in the PLX51-DL-232. 

Status.LoggingInhibited BOOL Not Used. 

Status.LoggingStopped BOOL Not Used. 

CachePercentage REAL The number of cached records not yet uploaded, as a 
percentage of the total record capacity of 16,777,216. 

CacheRecordCount DINT The number of cached records not yet uploaded. 

TotalRecordCount DINT The total number of cached records uploaded or not. 

ActiveTagCount DINT The number of individual tags configured to be read. 

DataSource.EtherNetIP BOOL Set if the data source is set to Logix. 

DataSource.DF1 BOOL Set if the data source is set to DF1. 
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Parameter Datatype Description 
DataSource.ModbusRTU BOOL Set if the data source is set to Modbus RTU. 

DataSource.ModbusTCP BOOL Set if the data source is set to Modbus TCP/IP.  

DataSourceReadCount DINT The number of tag reads from the configured data source. 

Important: The PLX51-DL-232 can poll single BOOL tags only. It cannot poll from an array of BOOL’s. 
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5 Diagnostics 

5.1 LEDs 
The PLX51-DL-232 provides three LEDs for diagnostics purposes as shown below.  

 

Figure 5.1  - Data Logger front view 

Table 5.1 - Module LED operation 

LED Description 
Ok The Ok LED provides information of the system-level operation of the PLX51-DL-

232.  
If the LED is green, then the PLX51-DL-232 has booted and is running correctly.  
If the LED is red, then the PLX51-DL-232 is not operating correctly. For example, if 
the PLX51-DL-232 application firmware has been corrupted or there is a hardware 
fault, Ok LED will be red.  

Act The Act LED is used for the RS232 serial port. For every successful received DF1 
or Modbus-RTU packet, the Act LED toggles green. The LED toggles red if a 
corrupted packet is received (eg. failed checksum). 

Eth The Eth LED illuminates when an Ethernet link is detected (by plugging in a 
connected Ethernet cable). The LED flashes when traffic is detected. 
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5.2 Module Status Monitoring 
The PLX51-DL-232 provides a range of statistics that can assist with module operation, 
maintenance, and troubleshooting. The statistics can be accessed by the PLX50 
Configuration Utility or using the PLX51-DL-232 web server.  

1 To view the PLX51-DL-232’s status in the PLX50 Configuration Utility, the PLX51-
DL-232 must be online. If the PLX51-DL-232 is not Online (following a recent 
configuration download), right-click on the PLX51-DL-232 icon and select the Go 
Online option. 

 

Figure 5.2 - Selecting to Go Online 

2 The Online mode is indicated by the green circle behind the PLX51-DL-232 in the 
Project Explorer tree. 

 

Figure 5.3 - Selecting online Status 

3 The Status window is opened by either double-clicking on the Status option in the 
Project Explorer tree, or by right-clicking on the PLX51-DL-232 icon and selecting 
Status. 
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4 The Status window contains multiple tabs to display the current status of the PLX51-
DL-232. 

 

Figure 5.4 - Status monitoring - General 
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5.2.1 General Tab 
The General tab displays the following general parameters as well as setting the PLX51-
DL-232 time to the PC time:  

Table 5.2 - Parameters displayed in the Status Monitoring – General Tab 

Parameter Description 
Data Source Logix, DF1, Modbus RTU, Modbus TCP/IP 
State This is the current state of the module.  

Running 
The module is reading tags and logging to the log. 
Stopped 
The module is idle and not reading tags or logging data. 

Logging Mode Hold or Overwrite – determines if records are overwritten when the cache is full. 

Logging State This is the current state of the logging in the module.  
Running 
Data is being read from the source and logged if the criteria is met. 
Running Rollover 
Data is being read from the source and logged if the criteria is met. In this state the 
event index has rolled over at least once. 
Inhibited 
The module has stopped reading and logging data, because the user has inhibited it 
from Logix. 
Stopped 
The module has stopped logging data, because it has reached maximum events and 
the module is set to not overwrite. 

Owned Indicates whether or not the PLX51-DL-232 is currently owned (Class 1) by a Logix 
controller. 

Up Time Indicates the elapsed time since the PLX51-DL-232 was powered up. 

Module Time Indicates the PLX51-DL-232’s internal time. The PLX51-DL-232 time is stored in UTC 
(Universal Coordinate Time) but displayed on this page according to the local PC 
Time Zone settings 

MAC Address Displays the PLX51-DL-232’s unique Ethernet MAC address. 

Temperature Internal temperature of the PLX51-DL-232. 

Processor Scan Amount of time (microseconds) taken by the PLX51-DL-232’s processor in the last 
scan. 

DIP Switch Position  Status of the DIP switches when the PLX51-DL-232 booted. 
Note that this status will not change if the DIP switches are altered when the PLX51-
DL-232 is running. 
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5.2.2 Statistics tab 
The Statistics tab displays the statistics of the record cache and data source. 

 

Figure 5.5 - Status monitoring - Transactions 

Table 5.3 – Cache Statistics 

Statistic Description 
Total Records The total number of cached records, uploaded or not. 

Cache Records The number of cached records not yet uploaded. 

Cache Percentage The number of cached records not yet uploaded, as a percentage of the total 
record capacity of 16,777,216. 

Active Tags The number of individual tags configured to be read. 

Data Source Reads The number of tag reads from the configured data source. 

Log Index The current record index being written to.  

Unload Index The upload record index. Managed by the Unload Service. 

Table 5.4 – Logix statistics 

Statistic Description 
Current Connections  The number of current open class 3 connections. 

Connection Failures The number of failed attempts at establishing a class 3 connection with a Logix 
controller. 

Tag Not Exist Errors The number of failed tag read/write transactions due to a non-existent destination 
tag. 

Privilege Violations The number of failed tag read/write transactions due to a privilege violation error.  
This may be caused by the External Access property of the Logix tag being set to 
either None or Read Only. 

Tag Reads The number of tag read transactions executed by the PLX51-DL-232. 
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5.2.3 Tag Status Tab 
The Tag Status tab provides current values for all tags, along with their trigger settings. 
The following tag mapping statistics are only relevant when the PLX51-DL-232 is 
running in either Reactive Tag or Scheduled Tag mode.  

 
Figure 5.6 – Tag Status 

Table 5.5 – Tag Status 

Statistic Description 
TagID Configured Tag ID for the specific Tag/Register/File. 

Device The configured source device where the tag is extracted. 

Tagname The Tagname configured for the specific tag. 

Value The last read value from the specific tag. 

Delta Y Configured deadband for the tag value. 

Time The time in seconds since the last data was logged. 

Min Delta Time Minimum time in seconds between consecutive data logging. 

Max Delta Time Maximum time in seconds between consecutive data logging. 
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5.2.4 Recent Records Tab 
The Recent Records tab provides a list of the last records recorded with their time stamp 
and value. 

 

Figure 5.7 – Recent Records 

Table 5.6 – Recent Records 

Statistic Description 
Index Logged data index. 

Date Time The time stamp when the data was logged. 

Tag ID Configured Tag ID for the specific Tag/Register/File. 

Device The configured source device where the tag is extracted. 

Tagname The Tagname configured for the specific tag. 

Value The last logged value from the specific tag. 
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5.2.5 Record Management Tab 
The Record Management tab manages the PLX51-DL-232 records. Records can be 
downloaded to a (.csv) file format. Options to reset the log indices and erasing the cache 
are also available. 

 
Figure 5.8 – Record Management 

Table 5.7 – Record Management 

Parameter Description 
Upload All Records to CSV Upload all records currently in the module. 

Upload Unread Records to 
CSV 

Upload unread records currently in the module. 

Reset Records Resets the log indices 

Erase Record Storage Erases the cache of all records 
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5.2.6 CIP Statistics Tab 
The CIP Statistics tab provides a set of Common Industrial Protocol (CIP) 
communication statistics. 

 

Figure 5.9 – CIP Statistics 

Table 5.8 – CIP Statistics 

Statistic Description 
Class 1 Timeout Count Number of times a Class 1 connection has timed out 

Class 1 Forward Open 
Count 

Number of Class 1 Connection establish attempts 

Class 1 Forward Close 
Count 

Number of Class 1 Connection close attempts 

Class 1 Connection Count Number of Class 1 Connections currently active 

Class 3 Timeout Count Number of times a Class 3 connection has timed out 

Class 3 Forward Open 
Count 

Number of Class 3 Connection establish attempts 

Class 3 Forward Close 
Count 

Number of Class 3 Connection close attempts 

Class 3 Connection Count Number of Class 3 Connections currently active 
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5.2.7 Ethernet Clients Tab 
The Ethernet Clients tab provides a count of EtherNet Client and EtherNet/IP 
connections.  

 

Figure 5.10 – Ethernet Connection Counts 

Table 5.9 – CIP Statistics 

Statistic Description 
ARP Clients Number of active clients in the ARP table 

TCP Clients Number of active connections in the TCP client table 

EtherNet/IP Clients Number of active connections in the ENIP client table 

Table 5.10 – EtherNet/IP Table 

Statistic Description 
IP Address IP address of the client in the ENIP client table 

Session Handle Session handle in the ENIP client table 
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5.2.8 TCP / ARP Tab 
The TCP / ARP tab lists the ARP and TCP/IP information associated with the known 
MAC addresses in the network. Parameters include the IP Address, Remote Port 
number, and Local Port number. 

 

Figure 5.11 – TCP and ARP Table Entries 

Table 5.11 – ARP Table 

Statistic Description 
MAC Address MAC address of the client in the ARP Table 

IP Address IP address of the client in the ARP Table 

Table 5.12 – TCP Table 

Statistic Description 
MAC Address MAC address of the client in the TCP Table 

Remote Port Remote TCP port of the client in the TCP Table 

Local Port Local TCP port of the client in the TCP Table 
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5.3 DF1 Packet Capture 
The PLX51-DL-232 provides the capability to capture the DF1 traffic for analysis.  

1 To begin the packet capture of the PLX51-DL-232, double-click on the DF1 Packet 
Capture selection in the Project Explorer tree. 

 

Figure 5.12 - Selecting DF1 Packet Capture 

2 The DF1 Packet Capture window opens and automatically starts capturing all DF1 
packets.  

Note: The PLX51-DL-232 keeps a circular buffer of the last twenty DF1 packets. Thus, there may be up 
to 20 packets in the capture that were received / sent before the capture was initiated. 

 

Figure 5.13 - DF1 packet capture 
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3 To display the captured DF1 packets, the capture process must first be stopped by 
pressing the STOP button. 

 

Figure 5.14 - DF1 Packet Capture complete 

The captured DF1 packets are listed as follows: 

Table 5.13 - DF1 Packet Capture fields 

Statistic Description 
Index  The packet index, incremented for each packet sent or received. 

Time The elapsed time since the PLX51-DL-232 was powered up. 

Status The status of the packet. Received packets are checked for valid DF1 
constructs and valid checksums. 

Dirn     The direction of the packet, either transmitted (Tx) or received (Rx). 

Src      DF1 node address of the message source. 

Dest    DF1 node address of the message destination. 

Description Brief description of the packet, usually the command. 

Address The string representing a PLC data address, where applicable. 

Detail Additional details associated with command. 

TNS Transaction number. Used to match request and reply messages. 

Data The packet’s raw data displayed in space delimited hex. 

4 The packet capture can be saved to a file for further analysis by selecting the SAVE 
button on the toolbar.  
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5 Previously saved DF1 Packet Capture files can be viewed by selecting the DF1 
Packet Capture Viewer option in the Tools menu. 

 

Figure 5.15 - Selecting the DF1 Packet Capture Viewer 

5.4 Modbus Packet Capture 
The PLX51-DL-232 provides the capability to capture the Modbus traffic for analysis.  

1 To begin the capture of the PLX51-DL-232, double-click on the Modbus Packet 
Capture selection in the Project Explorer tree. 

 

Figure 5.16 - Selecting Modbus Packet Capture 



PLX51-DL-232  Diagnostics 
Data Logger  User Manual 

 

ProSoft Technology, Inc. Page 51 of 59 
 

2 The Modbus Packet Capture window opens and automatically starts capturing all 
Modbus packets.  

 

Figure 5.17 – Modbus packet capture 

3 To display the captured Modbus packets, the capture process must first be stopped 
by pressing the STOP button. 

 
Figure 5.18 – Modbus Packet Capture complete 
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The captured Modbus packets are tabulated as follows: 

Table 5.14 – Modbus Packet Capture fields 

Statistic Description 
Index  The packet index, incremented for each packet sent or received. 

Time The elapsed time since the PLX51-DL-232 was powered up. 

Status The status of the packet. Received packets are checked for valid Modbus 
constructs and valid checksums. 

Dirn     The direction of the packet, either transmitted (Tx) or received (Rx). 

Node Modbus node address of the message destination. 

Description A brief description of the packet, showing the function and register range if 
applicable. 

Data The raw packet data. 

4 The packet capture can be saved to a file for further analysis by selecting the SAVE 
button on the toolbar.  

5 Previously saved Modbus Packet Capture files can be viewed by selecting the 
Modbus Packet Capture Viewer option in the Tools menu. 

 

Figure 5.19 - Selecting the Modbus Packet Capture Viewer 
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5.5 Module Event Log 
The PLX51-DL-232 logs various diagnostic records to an internal event log. These logs 
are stored in non-volatile memory and can be displayed in the PLX50 Configuration 
Utility or the web server. 
To view them in the PLX50 Configuration Utility, select the Event Viewer option in the 
Project Explorer tree. 

 

Figure 5.20 - Selecting the PLX51-DL-232 Event Log 

6 The Event Log window opens and automatically reads all the events from the 
PLX51-DL-232. 

7 The log entries are listed with the latest record at the top. Custom sorting is achieved 
by double-clicking on the column headings. 

 

Figure 5.21 – Module Event Log 

8 The log can also be stored to a file for future analysis by selecting the SAVE button in 
the tool menu. To view previously saved files, use the Event Log Viewer option under 
the Tools menu.  
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5.6 Web Server 
The PLX51-DL-232 provides a web server allowing you to view various diagnostics of 
the PLX51-DL-232 without the PLX50 Configuration Utility or RSLogix 5000. This 
includes Ethernet parameters, system event log, advanced diagnostics, and application 
diagnostics (DF1 diagnostics). 

Note: The web server is read-only, no parameters or configuration can be altered from the web interface. 

 

Figure 5.22 - Web interface 
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6 Technical Specifications 

6.1 Dimensions 
Below are the PLX51-DL-232 enclosure and DIN rail dimensions. All dimensions are in 
millimeters. 

 
Figure 6.1 - Module Enclosure Dimensions 

 

 
Figure 6.2 - Required DIN dimensions 



PLX51-DL-232  Technical Specifications 
Data Logger  User Manual 

 

ProSoft Technology, Inc. Page 56 of 59 
 

6.2 Electrical 
Table 6.1 - Electrical specification 

Specification Rating 
Power requirements Input: 10 to 28V DC,  (70 mA @ 24 VDC) 

Power consumption 1.7 W 

Connector 3-way terminal 

Conductors 24 to 18 AWG 

Enclosure rating IP20, NEMA/UL Open Type 

Temperature -20 to 70 °C 

Earth connection Yes, terminal based 

Emissions IEC61000-6-4  

ESD Immunity EN 61000-4-2 

Radiated RF Immunity IEC 61000-4-3  

EFT/B Immunity EFT: IEC 61000-4-4  

Surge Immunity Surge: IEC 61000-4-5 

Conducted RF Immunity IEC 61000-4-6  

6.3 Ethernet 
Table 6.2 - Ethernet specification 

Specification Rating 
Connector RJ45 

Conductors CAT5 STP/UTP 

ARP connections Max 20 

TCP connections Max 20 

CIP connections Max 10 

Communication rate 10/100 Mbps 

Duplex mode Full/Half 

Auto-MDIX support Yes 
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6.4 Data Cache 
Table 6.3 – Data Cache specification 

Specification Rating 
Max Record Count 16,777,216 

Maximum tag count 200 

Log criteria supported 
Delta change 
Heart beat 
Tag Triggers 

Minimum Log Interval 50 ms 

Data Types Supported BOOL, SINT, INT, DINT, or REAL 

Cached Records Non-
Volatile Yes 

Log triggers supported Yes 

Data Sources 
Logix Tags 
DF1 Files 
Modbus (RTU and TCP/IP) registers 

6.5 Serial Port 
Table 6.4 – Serial Port specification 

Specification Rating 
Connector 4-way terminal 

Conductor 24 to 18 AWG 

Isolation voltage 2.5 kV 

BAUD 1200, 2400, 4800, 9600, 19200, 38400, 57600, 115200 

Parity None, Even, Odd 

6.6 DF1 
Table 6.5 - DF1 specification 

Specification Rating 
Duplex Full/Half 

Error detection CRC, BCC 

Embedded response Auto, On 
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6.7 Modbus 
Table 6.6 - Modbus specification 

Specification Rating 

Supported Ports 
Modbus RTU 
Modbus TCP/IP 

Functions Supported 

Read Coils (Function Code 1) 
Read Discrete Inputs (Function Code 2) 
Read Holding Register (Function Code 3) 
Read Input Register (Function Code 4) 
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7 Support, Service & Warranty 

7.1 Contacting Technical Support 
ProSoft Technology, Inc. is committed to providing the most efficient and effective support 
possible. Before calling, please gather the following information to assist in expediting this 
process: 

1 Product Version Number 
2 System architecture 
3 Network details 

 

If the issue is hardware related, we will also need information regarding: 

1 Module configuration and associated ladder files, if any 
2 Module operation and any unusual behavior 
3 Configuration/Debug status information 
4 LED patterns 
5 Details about the interfaced serial, Ethernet or Fieldbus devices 

Note: For technical support calls within the United States, ProSoft’s 24/7 after-hours phone support is available for 
urgent plant-down issues.  

North America (Corporate Location) Europe / Middle East / Africa Regional Office 
Phone: +1.661.716.5100 
info@prosoft-technology.com 
Languages spoken: English, Spanish 
REGIONAL TECH SUPPORT 
support@prosoft-technology.com 

Phone: +33.(0)5.34.36.87.20 
france@prosoft-technology.com 
Languages spoken: French, English 
REGIONAL TECH SUPPORT 
support.emea@prosoft-technology.com 

Latin America Regional Office Asia Pacific Regional Office 
Phone: +52.222.264.1814 
latinam@prosoft-technology.com 
Languages spoken: Spanish, English 
REGIONAL TECH SUPPORT 
support.la@prosoft-technology.com 

Phone: +60.3.2247.1898 
asiapc@prosoft-technology.com 
Languages spoken: Bahasa, Chinese, English, 
Japanese, Korean  
REGIONAL TECH SUPPORT 
support.ap@prosoft-technology.com 

 
For additional ProSoft Technology contacts in your area, please visit: 
https://www.prosoft-technology.com/About-Us/Contact-Us. 

7.2 Warranty Information 
For complete details regarding ProSoft Technology’s TERMS & CONDITIONS OF SALE, 
WARRANTY, SUPPORT, SERVICE AND RETURN MATERIAL AUTHORIZATION 
INSTRUCTIONS, please see the documents at: 
www.prosoft-technology/legal 

 

https://www.prosoft-technology.com/About-Us/Contact-Us
https://www.prosoft-technology.com/ProSoft-Technology-Legal-Terms-and-Conditions
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